e17: System Panel, Part 2

e17 Accessories: ePDF & ePhoto

Using Scribus, Part 2: Starting The Project

SSH: An Easier-Than-You-Thought Tutorial

Computer Languages A to Z: Vala & Visual Basic

Game Zone: DOD:S & Steam Tips For Dual Booters

Calibre: A High Caliber Ebook Tool

Forum Foibles

Short Story: WWW Collapse

Firefox Add-ons: FireFTP

DVB Streaming in PCLinuxOS

And more inside!
| 3  | Welcome From The Chief Editor          |
| 4  | PCLinuxOS Artists Win First, Second Place |
| 6  | Screenshot Showcase                   |
| 7  | Calibre: A High Caliber Ebook Tool    |
| 12 | Forum Foibles: Welcome Newbies        |
| 14 | Double Take & Mark's Quick Gimp Tip   |
| 15 | Timeth's Christmas Present           |
| 16 | e17: Settings Panel, Part 2          |
| 17 | Screenshot Showcase                  |
| 18 | e17 Accessories: ePDF & ePhoto        |
| 21 | Customize Your LXDE Right Click Menu  |
| 23 | Screenshot Showcase                  |
| 24 | WWW Collapse                         |
| 32 | Using Scribus, Part 2: Starting The Project |
| 34 | Screenshot Showcase                  |
| 35 | Firefox Add-ons: FireFTP             |
| 38 | DVB Streaming In PCLinuxOS           |
| 42 | ms_meme's Nook: PCLOS B My Linux      |
| 43 | SSH: An Easier-Than-You-Thought Tutorial |
| 49 | Screenshot Showcase                  |
| 50 | Windowmaker On PCLinuxOS: Introduction|
| 53 | Computer Languages From A to Z: Vala & Visual Basic |
| 57 | Game Zone: DOD:S & Stream Tips For Dual Booters |
| 59 | Screenshot Showcase                  |
| 60 | More Screenshot Showcase             |
Welcome From The Chief Editor

Things certainly don't stand still in the Linux world. As usual, changes abound. Xfce 4.8, the newest release from the Xfce development team, has been released. Sproggy is busy building the new Xfce 4.8 components, and plans to have it released very, very soon. Meanwhile, KDE 4.6.0 has been released by the KDE development team, and Texstar is hard at work to bring the latest KDE 4 release to PCLinuxOS users. The Gnome developers have announced that the much anticipated Gnome 3.0 desktop is scheduled for release in April, 2011.

Many users have noticed that updates to the PCLinuxOS repository have temporarily stopped. ibiblio.org upgraded their servers, and the process didn't go as smoothly as it was planned. Never fear. Texstar is currently working with the ibiblio.org folks to resolve the issues. Hopefully, the situation will be resolved by the time you read this, or nearing resolution.

Why is the ibiblio.org repository so important? It is THE main repository that all of the mirrors sync with. So, without the updates to ibiblio.org, there are no updates to the mirrors. As a reminder, PCLinuxOS users should NOT use the ibiblio.org repository to update their installations. Doing so creates excessive server load on the main PCLinuxOS repository, and may slow the rate at which the mirrors can sync with the main repository. Instead, choose a mirror that's closest to your geographical location (other than ibiblio.org). This distributes the server load over many servers, which enables PCLinuxOS users all around the world to experience reasonably fast downloads and updates.

Personally, I like the speeds offered by the heanet and nluug servers, despite the fact that they aren't necessarily the mirrors that are closest to my geographical location. Even better yet, run the PCLinuxOS Repository Speed Test application, and choose the repository that gives you the best performance (other than ibiblio.org).

This month, we have lots of articles that I am certain will appeal to a lot of PCLinuxOS users, across the board. One that should find universal appeal is the special short story, WWW Collapse, by Alain Baudez, presented in a comic book panel format. The comic book characters were drawn by two of Timeth's students in Japan.

Meemaw continues her tutorial on using Scribus, with part two of her article series. She also brings us part two of her look at the e17 Settings Panel. Darrel Johnston takes a closer look at two of the accessory applications that accompany a typical e17 installation. We get to learn more about the two PCLinuxOS artists, ms_meme and Meemaw, who won first and second place in the LinuxGraphicsUsers.com Christmas wallpaper contest. We also take a look at Timeth's Christmas present to PCLinuxOS forum users.

I examine Calibre, the cross platform ebook tool that has become the "go-to" application for dealing with ebook files. I also take a look at how easy it is to use SSH, in my tutorial on the powerful tool that's available on virtually all Linux installations and distros. My Firefox Add-ons articles continue this month with a look at FireFTP, an FTP client that runs entirely within Firefox.

Game Zone returns this month with game review by glamerding, along with a way to run Steam on PCLinuxOS (if you dual boot with Windows). Leiche walks us through customizing the right click menu in LXDE's PCManFM, Longtom translates the DVB Streaming tutorial from Leiche's German site into English. Patrick Horneker kicks off a look at running WindowMaker on PCLinuxOS.

Eronstuc gives us another installment of his article series that marches through the alphabet of programming languages. Double Take & Mark's Quick Gimp Tip, along with Forum Foibles and ms_meme's Nook, are back for your monthly enjoyment.

So that's enough from me, until next month. Meanwhile, I wish each and every one of you peace, happiness, serenity and prosperity.
Ms._meme and Meemaw, two PCLinuxOS artists, won first and second place, respectively, in the Christmas Wallpaper Contest at the LinuxGraphicsUsers.com forum.

The contest was announced December 4, 2010, and ran through December 27, 2010. Forum visitors were then given a week to vote for their favorite contest entry, and the winners were announced on January 4, 2011.

From Dadster, one of the forum administrators there, made this announcement:

Voting is now closed and we have our two winners. Ms._meme with her swirltree_desktop and MeeMaw with her ChristmasCard.

I want to thank everyone who participated. Well done! All the artwork submitted was fantastic. Perfect examples of skill, time and imagination. They're a demonstration of what can be accomplished using Linux graphics software.

Please join in congratulating our winners, ms_meme and MeeMaw.

Ms._meme offered this about her wallpaper and about her win:

I enjoy using Inkscape very much. The members of the Linux Graphics Users forum have given me much encouragement. I struggled with the program for several years and finally got that "aha" moment. Now, a majority of my computer time is spent playing with it. I am very honored to have won the contest.

When I submitted my entry, I confessed that it was not an entirely original idea. I justify using others' ideas in the following way. When we cook, we use a recipe. When we sew, we use a pattern. But the outcome is our own, and we
can learn by trying to duplicate something and adding our own touches.

I had seen something similar to the Christmas tree, liked the idea and thought, "I can do that!" Whoa! Not so fast! Even the simplest looking things can be difficult.

My favorite part of Inkscape is pulling and tugging on those rascally little nodes. Of course Undo is also one of my favorite Inkscape activities. The outline of the tree gave me plenty of opportunity to commune with smooth and symmetric nodes. After getting the tree in shape, I searched for a Christmas ball tutorial and did a lot of copy/paste. I not only used the tree as my holiday wallpaper, but also made a smaller version to send as greetings to friends.

Last year I won 3rd place in the contest. I have informed the Linux Graphics Users forum to "Beware" as I have already started my entry for next year.

Meemaw offered this about her wallpaper and about her win:

I'm one of those people who changes their wallpaper all the time. Occasionally, I even set up my desktop to run through a slideshow of my favorite wallpapers. For years I have surfed the web to find wallpapers to use, but since I started creating wallpapers in Inkscape and Gimp, I don't search too much any more.

I really love making things in Inkscape! I feel so lucky to have won because there are so many talented artists on the Linux Graphics Users site. I love that forum as well and appreciate the support that all the members give each other.

Meemaw's second place entry, Christmas Card.

The card was not entirely my original idea. At work, we get catalogs of Christmas cards, and I saw one I thought was very pretty, so I tried to create something like it. I'm still learning, and I appreciate all the help and encouragement that I've received.

The rules of the contest were fairly simple. First, the wallpaper had to be done using open-source graphics software. Second, credit any part done by another when you submit the wallpaper. Third, all
wallpapers had to be submitted by midnight, December 27th, with winners announced January 3, 2011, after one week of voting by forum members. Fourth, there could be no controversial or pornographic artwork. Fifth, LGU administrators reserved the right to remove any artwork deemed to be inappropriate.

Both ms_meme and Meemaw won a Samsung Black DVD +/- RW burner, with LightScribe support.

Congratulations go out to these two very capable and excellent PCLinuxOS artists on their win! You can download ms_meme’s wallpaper and Meemaw’s wallpaper by following the respective links here in the magazine.

Reach Us On The Web

PCLinuxOS Magazine Mailing List:
http://groups.google.com/group/pclinuxos-magazine

PCLinuxOS Magazine Web Site:
http://pclosmag.com/

PCLinuxOS Magazine Forums:

PCLinuxOS Magazine Forum:
Main PCLinuxOS Forum:
http://www.pclinuxos.com/forum/index.php?board=34.0
MyPCLinuxOS Forum:

Posted by Yunn, January 9, 2011, running e17.
Calibre: A High Caliber Ebook Tool

by Paul Arnote (parnote)

Reportedly, one of the most popular gifts for the just-finished Holiday season were the various ebook readers. The marketplace abounds with choices: the Amazon Kindle, the Barnes & Noble Nook, the Sony Reader and the Ectaco JetBook line are some popular choices. Couple the standalone readers with the ebook reader apps that are available for all sorts of PCs, Macs, iPhones, iPads and Android devices, and it's easy to see how ebooks are rapidly broadening their appeal. Who wouldn't want to carry around 1,000 or more books in less space than that occupied by one book?

Background

I jumped on the ebook bandwagon about a year ago when I purchased an ebook reader for my wife. At that time, I purchased her an Aztk Mentor. It lasted about 3 months before rendering itself inoperable, despite the gentle use from my wife. The company that imports and markets the Aztk Mentor was incredibly difficult to contact for a resolution, so I purchased her an Ectaco JetBook Lite as a replacement. Currently, Aztk no longer sells an ebook reader and offers no support for Mentor on their site. The JetBook Lite seemed ok, but we could never figure out exactly how to get the performance from it that we expected, due to a firmware issue that prevented proper PDF text reflow. We missed the information in the user manual that the JetBook Lite works best with fb2, epub or plain text files as the ebook file format.

So, for this Christmas, I purchased her a Barnes & Noble Nook. Readers of The PCLinuxOS Magazine may recall that I had previously wrote an "ebook reader roundup article" in the January 2010 issue of the magazine, and the Nook was my choice for all-around best ebook reader out there. Out of curiosity, I started playing with the JetBook Lite about a couple weeks before Christmas. My wife's Nook was already wrapped and under the Christmas tree by this time, and I already knew that I would/could "inherit" the JetBook Lite after my wife got her Nook. Almost by accident, I discovered that the JetBook Lite prefers epub and plain text files over PDF files, which is the format that most of the ebooks in my library were currently stored as. I had made that decision long ago, due to the popularity and almost universal accessibility of PDF files, and so that I could have the option of reading my ebooks either on an ebook reader or on my computer screen.

For nearly all of my ebook library that was comprised of public domain classic literature, it was merely a simple act of re-downloading the content from Project Gutenberg in either the epub format, or as a plain text file. However, that left my about half of my ebook library still in the PDF format that was virtually unreadable on the JetBook Lite. As I soon discovered, I actually preferred the epub and plain text file formats, since they had smaller file sizes than PDF files. The smaller file sizes allow me to store more ebook files in a smaller space on the JetBook Lite.

Calibre to the rescue

One thing that new ebook users may find confusing is all of the different ebook formats. For example, the Nook supports the epub format, but not the mobipocket format. In sharp contrast, the Kindle
Calibre: A High Caliber Ebook Tool

supports the mobipocket format, but not the epub format. While both the Kindle and the Nook support and handle the PDF format quite nicely, the JetBook line supports PDF, but has difficulty displaying them in a readable manner, due to the aforementioned firmware issue (which is supposed to be fixed with a firmware upgrade). With free ebook content becoming increasingly easy to find on the internet, it can become quickly confusing. What if you find the content you are looking for, but it's not in a format that makes your ebook reader happy?

If you're looking for a way to convert between ebook formats, look no further than Calibre. It is a Python and Qt4 GPL v3 application that is able to convert between most of the ebook formats currently out there, without difficulty. The Calibre splash screen, shown above, is briefly displayed initially. Besides converting between ebook formats, you will soon find out that it even does much more.

You are then greeted with the main Calibre window, shown above. You will initially start off with a blank list, but you quickly remedy that by simply dragging your ebook files from your file manager and dropping them into the Calibre main window. Let's take a look at the main parts of the Calibre window.

At the top of the window is the toolbar, outlined in red in the screen capture above. All but one of the buttons have extra options available for them, signified by the down arrow next to them. The buttons are, from left to right: Add To Library, Edit Metadata, Convert Books, View, Choose Calibre Library, Donate To Support Calibre, Fetch News, Save To Disk, Connect/Share, Remove Books, Browse Calibre User Manual and Preferences.

The sort panel, also called the browser tag window, is at the far left, outlined in blue. Here, you select how you want Calibre to sort the library, and set how you want the library displayed. Outlined in yellow, below it, are drop down lists that you can also use to sort your Calibre library, as well as search criteria and to manage categories of books in your library.

Your Calibre library list of books is shown in the screen capture above, outlined in black. Double clicking any title in the library list will open that book using Calibre’s internal ebook viewer.

At the far upper right of the Calibre window is a preview window that displays the cover of the selected ebook, outlined in magenta. Below that, in the lower right corner of the Calibre window and outlined in orange, are some buttons that help to further refine how your library is displayed, as well as a progress indicator of the conversion jobs that Calibre is performing. I'll discuss the leftmost button in the orange section separately, below. The second button toggles the browser tag window (outlined in blue). The third button toggles the preview window.
What else can it do?

If all Calibre did was convert between the various ebook file formats, that alone would be enough. But Calibre does much more than that. Calibre allows you to sort, maintain and categorize your ebook collection. With Calibre, you can edit the metadata that is stored in the ebook file format, which is used by many ebook readers to display the "table of contents" list of the ebooks that are stored on the ebook reader.

Calibre also assists with loading your ebook content onto your ebook reader. This is especially handy if you are using an ebook reader that loads the ebook files to the ebook reader’s internal memory. When you plug your ebook reader into your computer, icons for the ebook reader and any extra memory cards your have installed on that ebook reader will appear on your toolbar. You "eject" or "safely remove" the ebook reader and additional memory card from within Calibre, using the options under the toolbar buttons. Attempting to eject the devices from your device notifier will result in an error.

If you are someone who likes to stay abreast of current events, then Calibre has you covered. Clicking on the "N" icon on the toolbar will allow you to configure and/or download news content directly to your ebook reader. You can select content to be downloaded daily, weekly or monthly, depending on the periodical's publication frequency. You can choose from daily newspapers, such as the Dallas Morning News, the Kansas City Star, the Indianapolis Star, the New York Post, the Wall Street Journal, and many other newspapers from all around the world. Similarly, you can choose to download content from magazines, such as Time, Newsweek, Rolling Stone or many other magazines. You can even download content from 24 hour news outlets, such as the Associated Press, Reuters,UPI, CNN or Fox News. You can even add in your own custom news feed sources. All totaled, Calibre comes pre-configured to download from 714 different news feeds. Some, such as the New England Journal of Medicine or the New York Times, require you to enter your subscription information (sorry, no free ride here). The graphic below (next page) shows an article from the Kansas City Star, displayed in Calibre's built-in ebook viewer.

Where Calibre really shines is in its ability to convert between the many different ebook file formats that are out there. First select the ebook file you want to convert from the list in the Calibre library window (you can select multiple books by holding down the Ctrl key while selecting them with your mouse). Next, select the third icon from the left on the toolbar.
Old building, new luster: Project gives downtown housing a boost

By KEVIN COLLISON
Posted on Thu, Dec 30, 2010

An outdated downtown office tower that’s been empty since the late 1990s is ending the year as a 134-unit apartment building — one month ahead of schedule.

The Grand Boulevard Lofts building has opened for leasing, and the developer of the former Home Savings Association building at 1006 Grand Blvd, believes it should fill quickly.

Monthly rents range from $566 for a one-bedroom apartment to $775 for a two-bedroom unit.

"The downtown market still seems to be strong for apartments," said Ryan Saile, vice president of development for Minneapolis-based Sherman Associates.

There isn't sufficient space here to go over every option that is available for converting from one ebook file format to another. For that, as well as the full details about the operation of Calibre, I recommend that the user consult the full Calibre user manual. On this screen, you can set the metadata that is stored with many of the ebook file formats. The metadata is used by many ebook readers to display the information about each individual ebook in your library. Look & Feel dictates how your ebook text is formatted on the screen of your ebook reader, from default line spacing to the default font size to use when displaying the file.

Page Setup allows you to tell Calibre which ebook reader you will be viewing the ebook files on, as well as setting up the default margin sizes for the ebook reader's screen. Structure Detection fine tunes the detection of chapter headings and other elements of the document structure. Table of Contents allows you to set extra parameters for the construction of the table of contents. Output allows you to make additional settings for the output format you have chosen, and as you might imagine, those settings can vary with the different ebook formats.

You can change the output format in the upper right corner of the window by selecting your desired ebook file format from the drop down list. The file input format, in the upper left corner of the window, is usually auto-detected and preselected for you. Just be forewarned that Calibre will not convert DRM protected ebook files. You will have to first remove the DRM protection, and that is a topic that is far beyond the scope of this article. Just suffice it to say that it isn't as difficult as you might think, although a Linux-based solution does seem to be rather elusive.

Configuring Calibre

The first time you run Calibre, you will be greeted with the “Welcome Wizard” screen. Here, you will specify the directory in your /home directory to where Calibre will save your ebook library. Once you've specified the directory for the Calibre library, click on the "Next" button.

In the second screen of the Welcome Wizard (next page), you can select the make and model of your ebook reader. Calibre will use this information to help optimize the layout of the text for your ebook reader's screen. The third screen of the Welcome Wizard is a congratulatory confirmation screen.
There are five separate categories of configuration options for specifying how Calibre handles your ebook data. The “Interface” category allows you to tailor the information that is displayed on your computer screen. The “Conversion” option allows you to tell Calibre what the preferred options are for input and output, as well as options that are common between all conversions. The options under “Import/Export” allow you to tell Calibre how to handle the options for importing and exporting the various ebook file formats. “Sharing” allows you to share your converted ebook files, either via email or over a server on the internet. Finally, under the “Advanced” settings, you can manage the plugins that are available for Calibre, manage tweaks to Calibre, or access settings that don’t fall into any particular category.

Conclusion

Calibre sets out to be a one-stop tool for managing the ebook files in your library, and accomplishes that task admirably. There are versions of Calibre for Linux, Windows and Mac OS-X, making it a true cross-platform solution for managing your ebook library. Additionally, Calibre gives you the option of downloading your daily news from various periodicals around the world. And, should you ever change your ebook reader from one brand to another, Calibre’s ebook file conversion features are sure to save you from the untold grief of having to repurchase your entire library in another format, which can be an extremely expensive proposition. Instead, you can simply convert your existing files (all but the DRM protected ones, anyways, and even that issue can be resolved) to the preferred format for your new ebook reader.

Calibre exists in a league of its own when it comes to ebook tools. There literally is nothing else like it in the computing world. It is rapidly gaining the reputation of being the “go to” piece of software for virtually all of your ebook file handling needs. I can vouch for that, since Calibre has saved me a lot of effort in converting my ebook library to file formats that are better handled and “more preferred” by my ebook reader.
Welcome to the Nut House. *Sproggy*

You'll find a friendly bunch here, just a little wacky, but helpful all the same. *wayne1932*

Welcome home to PCLinuxOS! You may get bored around these parts...there's rarely anthing to fix, *parnote*

Welcome to our little loony bin on the net that we call home. *old-polack*

Average age in the sandbox varies depending on how much root beer they've had. *Dragynn*

Be welcome here. It's a great bunch of folks, and very helpful for those instances where we find ourselves knowing just enough to get into trouble. *Padma*

Glad to have you here, the distro is very stable so if you're bored go to Sandbox and meet all the gang. *Crow*

Don't panic for the penguins, here same users crazier *Leiche*

Glad to have you here with us...welcome to our family of nutters. *scoundrel*

---

**WELCOME NEWBIES**

What is a Newbie the forum scholars contemplated
They sought out each other and the answer they debated

A newbie is one who needs first a thing that works
Then later can spend time learning all those extra perks

A newbie may want to learn much more 'tis my guess
But takes a lot of time to straighten out the mess

A noob may know plenty in his own chosen lot
But finds when he changes he knows a bunch of naught

I laughed and I chuckled at the scholars' serious chatter
And thought to myself what the heck does it matter

Anyone trying something new will be one by and by
So what is a Newbie ...... to me it is I

But in the PCLOS Forum a newbie is a means to an end
For if you're newbie there it means you are a new friend

---

Check out the sandbox section in the forum if you want to get less serious and have some fun with the other (inmates) members. *critter*

PCLinuxOS community is a beautiful, quaint community conveniently located close to everything, yet set back away from the daily hustle and bustle. Come visit us today. *slax*

People from all over the world are gathered here and on occasion you will meet some very odd ones. *DutchWolfie*

You have found a great home and sandbox to play in. *smileeb*

I'm sure you are aware of the crazy Sandbox section where lots of us hang out. Join us and have some chuckles. *menotu*

Enjoy, and don't mind the crazy loonies here - they're usually pretty friendly when you look a little deeper. *tschommer*

Good to have you join the gang. *kc1di*

It is much fun here on the forum (And in the sandbox to build sandcastles) *longtom jr*
Hello Newbies Well Hello Newbies
Welcome Home this is where you belong
PCLOS is swell Newbies it excels Newbies
It's a growing and a flowing always going strong

Just see that Sandbox a swayin'
Where the gang's all a playin'
PCLOS forum will last your whole life long
So log in now hear Texstar's cats meow

You will never go away
You will be here to stay
You will never go away again
Double Take & Mark's Quick Gimp Tip

Mark's Quick Gimp Tip

Just the other day in the area I live, thunder and lightning accompanied a snowstorm. This reminded me of a blog post I did about protecting your system in a lightning storm. It also reminded me of how I created a Lightning bolt. I needed an image for the post, and quickly turned to The Gimp to create it. And it was easy! The great thing about Gimp are the many plugins available, not only in the PCLinuxOS repository, but on the web. For this project, I went to Deviant Art and downloaded lighting brushes for Gimp. You can get those here. Extract the file and drop it into your /gimp/brushes folder. Then, Open Gimp, select the brush tool, scroll down the brush tool menu and select a lighting bolt. Adjust the color and size and click the mouse on your canvass. You've just created a lighting bolt! Use a dark solid color as a background so the lighting effect stands out. For added effect, I used a dark gradient. Get PCLinuxOS, Get Gimp, get creative!

-Mark Szorady is a nationally syndicated cartoonist with georgetown.com. He blogs at georgetoon.com/blog. Email Mark at georgetoon@gmail.com.
In December, 2010, PCLinuxOS artist Timeth presented the PCLinuxOS community with a suite of user and blog bars that users can download and use for branding and decorating their forum posts and emails. Timeth has created graphics that are attractive and easy on the eye, without being obnoxious and obtrusive.

Any visitor to the PCLinuxOS forum can bear testament to the popularity that these graphics have developed. Timeth’s user bars encompass all of the desktop environments that PCLinuxOS is offered in, as well as status messages for PCLinuxOS users, administrators, moderators, and a host of other identifiers. Timeth even provided some special ones with customized messages.

Timeth hopes that users will use the user bars and blog “bling” to help get the word out about PCLinuxOS, attached to the signature portion of their email, as well as in their signatures in other forums that they may visit.

On behalf of the PCLinuxOS community, Timeth, we thank you for your gift to the community. To get your PCLinuxOS user bar, or a decorative graphic for your blog, head over to Timeth’s web site and download the one (or ones ... or all) you want.

And, to show our thanks, ms_meme has created an original bit of prose:

Thanks to you dear timeth for giving us user bars,
You’ve made us feel so special we are PCLinuxOS stars.

We show them off with pride for everyone to see,
And we are so very glad that you are so art-sy.
by Meemaw

We continue our exploration of the E17 Settings Panel. The next four sections are Menus, Language, Files and Input.

The fifth section is Menus.

Menu Settings - Which and how menu items are shown in the menu.

Client List Menu - Controls the grouping of current open windows.

The next section is Language. --->

Language Settings - If you are not a native English speaker, you will find this option helpful to change the language of Enlightenment to your preferred one.

Input Method Settings - Select the input method. The default is for Smart Common Input Method, of SCIM.

The next section is Files --->

File Manager - Sets defaults to be used by e17’s file manager.

File Icons - Select file associations for different types of files, and the icon to display.

Places - Select default folders to show in left pane of file manager.

The next section is Input. ----->

Key Bindings - You can configure 'hot keys' for certain commands.

Edge Bindings - Here you can configure what will happen when the mouse goes to or clicks on an edge of the screen.

Interaction - Enable/disable thumscroll.

Mouse Bindings - Using multiple mouse buttons at the same time can also do something special. This is the place where you can configure this.

Mouse Settings - This configures your mouse for left or right hand and gives settings for acceleration and threshold.

Next month we'll finish out the items in this window.
Screenshot Showcase

Posted by ongoto, January 21, 2011, running Gnome.
by Darrel Johnston (djohnston)

Most of us make sure we have a PDF reader and a photo viewer on our selected desktop. When you are using E17, an option for each program is ePDF and ePhoto.

ePDF

ePDF is a lightweight viewer for pdf files. It doesn't have as many options as Adobe's reader.

There is a Select Text icon in the toolbar, but I could not find a way to copy the selected text to the clipboard. (right top)

The File menu options are pretty standard. (right center)

The Edit menu options are sparse. Notice the absence of any copy, cut and paste functions. (right bottom)

Shown below is the result of selecting Edit Preferences from the program menu. The only option is to select an external web browser.

ePDF is supposed to be light on resources. When viewing some of the PCLinuxOS magazine issues, I saw CPU loads of as high as 99%, and a few seconds of lag times when going from one page to the next. This happened whether the window was at default size or maximized to screen size.

ePhoto

ePhoto is an e17 application for viewing graphics files. When viewed, each image is scaled to the display window size. If you have a very large window for ePhoto and display a small image, the image will be enlarged to the window's size, and can appear to be very grainy. I could find no option to change this characteristic of the program. If ePhoto is started from the Graphics section of the menu, it will appear as it does below. (next page)

Clicking on the Change Directory icon brings up the file requester window shown next page. (bottom left) The default starting directory is your home directory. Note that there is no slider.
The size of the thumbnails can be changed with the Thumb Size slider in the lower right corner of the window.

By left-clicking on one of the folders and holding the left mouse button down, a slider will appear to the right. To slide the directory list downwards, you must move your mouse upwards. To slide the list upwards, you move the mouse downwards. This seems to be counter-intuitive. In any case, once you let go of the left mouse button, the slider will disappear in about three seconds.

Shown below is the result of either clicking on the View Large icon in the top toolbar or double-clicking one of the shown thumbnails. Click the Go Back icon on the bottom toolbar to return to thumbnail view. You can cycle through the directory's graphics files using the green arrow icons.

Here I have selected a directory, and all graphics files within that directory are displayed as thumbnails.
Clicking the Slideshow icon in the bottom toolbar or the Play Slideshow icon in the top toolbar will display a slideshow in the display window. I found no full screen slideshow option. The slideshow will continuously cycle through the list until you single-left-click on the picture being displayed. You will then be returned to the thumbnails display.

Conclusion

As you can see, ePDF and ePhoto are capable native e17 applications, but lacking in features that are found on many other applications that exist for the other desktop environments. It’s not certain if the lack of features is due to the beta nature of the e17 desktop, or if those features have been left out to make for lighter-weight applications that will run with a minimal memory footprint, much as the rest of e17 has been designed to perform.

ePDF can easily be replaced with more capable PDF viewers, and the choice varies with whether you have the Qt4/KDE version of e17 installed, or the G tk+ based version. Under the version of e17 that is based on Qt4/KDE, you may want to give Okular a try, while on the G tk+ version, Evince or ePDFViewer make good, lightweight alternatives. Similar choices exist for ePhoto.

Still, if you’re looking to stick to native e17 applications, then you are likely to find ePDF and ePhoto suitable for most of your PDF and photo viewing needs.

Meemaw and parnote also contributed to parts of this article.
Customize Your LXDE Right Click Menu

by Daniel Meiß-Wilhelm (Leiche)

You have downloaded an ISO, and you want to burn it to an optical disc. You can use Xburn, Brasero, Simple Burn, and sometimes K3b. I use K3b on another of my installations, while I use Brasero on my LXDE installation.

We have installed Brasero via Synaptic. Maybe if we are lucky, Brasero is now in the right click menu when you right click on an ISO file.

It isn't, so we need a simple right click menu to perform some actions, and we can do this:

1. Select a file, maybe an *.iso file, right click, and choose "Open With..." from the context menu.

2. In the next window, select Custom Command Line, and enter the command line to execute:
   
   `brasero --image %f`

3. If you now right click again on the file, you will see a new entry called brasero - -image. Select it, and brasero is ready to burn your *.iso file. Don't forget to put a blank CD or DVD in the drive.

If no CD or DVD is in a drive, Brasero will display a message, reminding you that you need to put a blank CD or DVD in your drive.

Now, we want to change the name of the entry, and add a stylish icon. We need to open a hidden directory in our home directory. The simplest way is to open PCManFM, the LXDE file manager. Right click on an empty spot, and PCManFM will display the following context menu.

- New
- Paste
- Select All
- Sort Files
- Show Hidden
- Properties
Select Show Hidden from the context menu, or use the keyboard shortcut “Ctrl+H.” Navigate to .local/share/applications. Choose the file brasero -- image with a right mouse click, and select Open with... > Leafpad.

With Leafpad, you can edit the desktop file.

By the way, we see that a desktop file called userapp-brasero --image-4DPIPV.desktop, but we only read brasero --image. This is not an important issue for us. What we must change is only the name. Edit the “Name” line, for example, to Brasero Image Burner, or only Brasero. I think that the shorter the name is, the better it is. We also added the “Icon” entry. You will find most icons on your system stored in the /usr/share/icons directory. You can view the icons in PCManFM as thumbnails.

Don’t forget to save your custom changes. If you now click again on an *.iso file with a right click, you will see this:

Isn’t it easy?

You can add command with more actions, maybe with:

```
xterm -hold -e "su -c 'apt-get install %f'"
```

Just keep in mind that it is not recommended that you install packages from outside the repos for multiple reasons.

Enjoy!
Answers to Mark Szorady's Double Take:
(1) Luggage sticker changed; (2) Groundhog smiling; (3) Nose smaller; (4) Snowfall missing;
(5) Luggage handle missing; (6) Golf club missing; (7) Snow pile missing

Posted by coffeetime, January 25, 2011, running WMii.
by Alain Baudez (Wamukota)

Prologue by Paul Arnott (parnote)

On April 17, 2010, Alain Baudez (a.k.a. Wamukota) sent me a short story he had written, and asked me if I would be interested in running it in The PCLinuxOS Magazine. Set in the not too distant future, it’s a story depicting the collapse of the World Wide Web.

I looked everywhere. I checked with the usual PCLinuxOS artists, but all said that this was something that they felt was outside of their graphics abilities. However, one such contact did lead to another lead, which I pursued. Timeth, an Australian PCLinuxOS user and artist who teaches in Japan, had some students who were quite skilled at anime-type drawings, and he thought that they would be able to do a good job.

So, I sent Alain’s manuscript to Timeth, and he shared it with them. They were interested. So off they headed, working in their spare time to create a multi-panel comic book style presentation for Alain’s story. After several months, their outstanding work appears here.

“One of my other hobbies is writing short stories. I’ve done that since I was a teenager and now, at the age of 54, I still love to write. I normally write stories in Dutch, but once in a while, I like to try it in another language. When I write some SciFi or Fantasy stuff, it just makes sense to do it in English,” said Alain about his story.

“I really can’t recall what gave me the idea, but this story is simply one of the many plots I came up with, where I play with the infamous Dec 21, 2012 date. According to some, that date means the end of the world, and in my story it is simply the end of the WWW as we know it.

“Also hint at the freemasons at the end of the story. You know they exist, but you don’t know who is a member. Between them, they have special secret signs, which I refer to with the i-letter.”

I would like to share the names of the students in Japan with the rest of you, but privacy laws in Japan prevent me from publishing their names here. So, we’ve given them nicknames. They are two female junior high school students, Moto-san and Hina-san. So to Moto-san and Hina-san, if you are reading this, I’d like to personally congratulate you on the outstanding job you did with this project. You can certainly be very proud of what you have helped create here. Plus, I would like to thank you for your hard work on this project.

This has truly ended up being an international endeavor. Alain Baudez, a PCLinuxOS user from the Netherlands, wrote the story. He sent it here to me, in the United States, to publish it. I sent it to an Australian, teaching in Japan, to find a way to illustrate it. And his students, from Japan, came through with the illustrations.

I hope you enjoy the story, along with the comic-book presentation, exclusively here in The PCLinuxOS Magazine.
Come over here, I will tell you a story.

Great. Grandpa, is it about the World Wide War?

Och, that WWW has something to do with it, but what I am to tell you happened even earlier and then we talk about another, less known event, the World Wide Web collapse. Your mum told me that you visited the Museum of Electronic Artifacts last week. Did you visit the computer aisle?

Yes. There were some weird machines. You had to type on a kind of letterboard.

That is called a keyboard.

Ach, and the result of what you typed appeared on a solid screen. Very funny.
Well, those were the kinds of machines I used to work with some 70 years ago. They are called Personal Computers.

Cool!

Let me ask you a question. When did the WWW collapse occur?

They told us December 21, 2012.

Right. And what happened?

A kind of infrastructure called the internet collapsed, but they didn’t tell us why.

At that time I was about your age, and the story I will tell you is known by few but is all about that collapse. Those PC’s you saw needed a kind of program to make them work. That program was called an operating system. Prior to the WWW collapse, all PC’s were running the same program made by a company called Microsoft. Their operating system was called Windows.
What a strange name for a program. But why was only one company making that OS, unlike today when we where we have hundreds of systems?

That is not fair. You need that program to make the machine run, and even then they charge you.

It was the time where money was more important than human well-being. The company charged you for using their program...

Yes, that was the way it was. Everytime you acquired such a machine, you paid that company for their OS. You could not buy a machine without it. And what was even worse was that the OS was closed source...

Grandpa, what is closed source?
Och, well it is the opposite of what we have today. You see the food creator machine there? We both like a good cheeseburger don't we? But your taste is different than mine, so we modify the cooking algorithms in that machine so that not only we know what the machine puts in there - we wouldn't like to be poisoned - and we make sure that the burger is exactly the way we like it. You could say that this is open source. You look into the inner workings of the machine so that you know how it works, what it is doing and you can modify it if you have to. Closed source is the same machine with just one button: Make Cheeseburger. You don't know how it makes it, nor what ingredients are being used. You cannot intervene in the cooking process. Would you like such a burger?

Och no, I would never trust such a machine.... and you worked with such a machine?

I didn't, but most if not all companies did as well as citizens.

You didn't? What did you do then?
There was something called Linux. That was an open source OS, that was used by a tiny group of enthusiastic users. We used it on the same PCs but our OS was better, more secure, ran faster and we had it for free.

Cool, you were a rebel then Grandpa?

Ha, no not a rebel but let me tell you that people knew that I didn't follow the mainstream 'flock-like' Microsoft indoctrination and they didn't like it. They were so brainwashed into their belief that only Microsoft could write good programs that everything else was evil to them.

Wow, and then...

One day, and you know which date don't you, December 21 2012, a group of terrorists attacked the Windows OS and took over all those machines. In a period of 24 hours all Windows machines were dead. They controlled everything, or so they thought.

Who were those terrorists?
You will not find their names in any history book, as history books are always written by those who won, but their banners showed a kind of apple in it.

So, where was I, hmmm yes. Those Apple warriors thought they had everything under control, but we Linux users were immune to their attacks. Our system was so good that not only did we not suffer any losses, but we were able to counter attack. A few great minds of our community hacked the Linux code and we uploaded it to all PC’s that were under control of the terrorists. It happened so fast that the Apple leaders were unable to stop us, and in a few hours the Linux machines ruled the World Wide Web.

Holy cow, and you were there when all that happened. Geez, what a cool period to have lived in.....real cyber wars.

Hence the double meaning of WWW. I knew it as World Wide Web but you know it as the World Wide War.
But Grandpa, what happened to that Microsoft company?

Them? We never heard anything of them since. No, Linux has been on all systems for more than 70 years now....

And what about those Apple warriors? Are they still around?

Och, yes...

Oh, and how do you recognize them?

What I'm gonna tell you must be kept a secret. OK?

OK.

They have names, companies, cars where the brand name begins with the letter 'i'.
by Meemaw

In Part 1, we became familiar with some of the Scribus tools, learning how to open a new document and format the page. We also learned about frames and how to add a text frame and an image frame. Those are the basics to starting a poster, newsletter or brochure.

Since the majority of my work in Scribus is the magazine and the newsletter at work, we should go through the steps for creating a newsletter. (The magazine just has more pages). Before you start adding text frames randomly to a page, you will probably need to do a little planning. Decide on these beforehand:

1. **Page size** - Is this something you are going to print out and mail? What size paper will be the best? For my newsletter at work, the answer is yes, they will be printed and mailed, and letter size is what I use.

2. **Orientation** - Will it be more easily read in portrait or landscape? My newsletter is portrait, but since the magazine is read mostly from a computer screen, we find that the most popular orientation is landscape.

3. **Margins** - You can make really small margins if you want, but if it is to be printed, your printer may not be able to print them, especially the bottom margin. You also want to stay away from filling up every available space on the page as it can make your newsletter harder to read.

4. **Design** - Are you going to have some sort of title header on page 1? How big do you want it, and what will it look like? If you are printing it, will it be in color or just black?

When you get an idea of your layout and design, it’s time to start. For this article, the newsletter will be letter size, portrait orientation, with 0.25 inch margins and a small header on each page. The bottom margin will be 0.5 inch to accommodate my printer.

Open a new document, making it letter-size, portrait and 0.25 inch margins at left right and top, and a 0.5 inch margin at bottom. Newsletters can be just text, but a title header catches the reader's eye. Let’s do a title header on the first page. Click on the shape tool, and draw a rectangle. In the Properties window, set the width to 8 inches and the height to 1 inch, the set the X-Pos and Y-Pos each to 0.25 inches (your margins). If you haven't named and saved your file yet, you should probably do that.

The default color is black. We want to change that, so click on Colors (at the bottom of the properties window) and...
assign a color. I used blue. Make sure the 'fill' button is clicked (looks like the pouring paint bucket.) You can also use a gradient; it is in the drop-down above the list of colors. The one I used was a vertical gradient. When you choose gradient, it opens another item, which is the box where you configure your gradient. Notice I have configured one 'end' of the gradient blue, and the other white. The red triangle under the gradient configuration tells which color you are changing. On a vertical gradient left is top and right is bottom. If you want a border too, you should click the 'line' button (looks like the paintbrush) and set it there. I set my border to None. (Save)

I wanted rounded corners on my rectangle, so I clicked on Shape in the Properties box, and set the measurement on Round Corners (top of window) to 0.3500. The higher your number is, the more rounded your corners will be.

From there, I messed around a little more and made another rectangle, this time with a radial gradient. I wanted it in the exact center of the other gradient, so I clicked on Window > Align and Distribute so I can center everything. Click on the bigger rectangle first, then, holding down the Shift key, click on the smaller rectangle. In Align and Distribute, you will see 'Relative to' and a drop-down next to it. It should say 'First selected' -- if it doesn't, change it using the drop-down. The click on the two centering buttons (each in the center of their respective lines.) You can also choose to center an object on the page, changing the 'Relative to' drop-down to Page. (Save your work.)

If you are happy with what you have done, you should lock it down so you don't move or resize it by accident. Click outside both rectangles, and drag a rectangle shape. You should be able to see a rectangle surrounding your header. Let the button up on your mouse, and you will see that both rectangles have been selected. You can select them one at a time like we did before, but if your hand shakes at all you may move one by mistake and have to go back and align again.......

In your properties box, go back to X,Y,Z and you should see two buttons in the center that aren't grayed out. One has the outline of several shapes and the other is the lock. The first one is the 'Group' button, which you can use to make the rectangles into one item that is combined. When you do that you can move them both just by grabbing one of them. If you have a group you want to copy and use over and over, this is a benefit. Click on Group, then click on the Lock. The lock does just that - locks your item in place so it can't be moved or changed by accident. The icon will change from an open lock to a closed one. (Save)
Now we want our title. Click on the text frame button and make a rectangle over your header. Click on the 'Edit Text' button on the toolbar, or right-click in the text frame and choose Edit Text. There are many configurations in the Story Editor window but they don't always stay, so we do most of that from the Text section of the Properties window. You can do loads of things with your text. Choose your header, then your text and center the text, left to right, then lock it in place. You will probably get a message that some of your objects are locked. We know that because we locked the rectangles down earlier, so click on 'Skip Locked Objects' and the text will be centered in the rectangles. You also want to save your file again.

You can start adding text frames with news stories and image frames for pictures if you wish. Next month we'll explore more of how to get our newsletter looking the way we want.
FireFTP was created by Mime Čuvalo, when in 2004, he discovered a new web browser called Firebird. Of course, Firebird later came to be known as Firefox. Having just completed his computer science degree, and being bored out of his mind, he set out to see if he could create something useful for the new web browser, and FireFTP was born. Since its inception, FireFTP has been downloaded over 18,000,000 times, and is in use all around the world. The most current version is version 1.0.10.

Nearly everyone, I'm sure, has downloaded files from an FTP (File Transfer Protocol) server. Many of us have had to maintain a web site, and find it much easier to upload files to that web site from FTP client software, of which there are many available. Then along comes FireFTP, the Firefox add-on that will allow you to use your Firefox web browser as your FTP client to upload and download files from an FTP server.

As far as I can tell, FireFTP is about the only Firefox add-on that turns Firefox into a FTP client. In fact, I use it frequently to upload files to the PCLinuxOS Magazine web site every month.

About FireFTP
While FireFTP is free, its author asks for donations. One-half of the donations go to help feed him and his family, while the other half of the donations go to help support the various orphanages in Serbia, Croatia and Bosnia-Herzegovina.

**Using FireFTP**

When you select the FireFTP menu entry, under Firefox’s Tool menu, you will see a screen similar to the one on the previous page, lower right. In the upper left hand corner of the window is a drop down list to allow you to choose from the FTP servers you have configured that you may want to connect to. After selecting the FTP server, simply click on the "Connect" button and you will be connected with the selected FTP server.

The left hand pane of the window displays the files and directories on your local computer, while the right hand pane displays the files and directories on the remote computer. To transfer files, navigate to the folder on the remote computer to where you want to upload the file. Then, navigate to the folder on your local computer that has the file you want to upload, highlight it, and select the green arrow (center of the screen) that's pointing to the right.

Downloading files from a remote FTP site is just as easy, but in reverse. Navigate to the directory on your local computer where you want to store the file(s). Then, go to the directory on the remote computer that contains your file(s), highlight it (them) and select the green arrow in the middle of the window that's pointing to the left.

The pane at the bottom of the FireFTP window displays the messages from the FTP server, such as file transfer data and speed, login information, and any other data that the FTP server may be sharing with your local computer.

At the very bottom right of the FireFTP window is a progress indicator, which will display a progress bar for files that are being uploaded or downloaded. Just to the left of that progress bar, FireFTP displays how much of the file(s) have been uploaded or downloaded, in kilobytes, as well as the current transfer speed.

When you right click on a file, FireFTP will give you a popup context menu with additional tasks you can perform, like creating a new directory, creating a new blank file, deleting or renaming a file, or even copying the URL of a file (so that you can link directly to it later). We’ll talk a little bit more about this latter task later, when we talk about configuring FireFTP.

**Configuring FireFTP**

By clicking on the "Edit" button in the upper left corner of the FireFTP window, you will get the multi-tabbed configuration dialog box shown below.

If this is the first time you’re setting up FireFTP, all of the data fields in the dialog box will be empty. The first tab is the "Main" tab, which is divided into two sections, main details and ID. The main details section is where you enter your account name, assign it a category (if you choose), and specify the host. Under the ID section, you enter your login name and your password, if applicable. Some FTP servers allow you to log in as “anonymous," and if that is the case, simply check the "Anonymous" check box instead.
The "Connection" tab is divided into two sections, as well. Under the "Connection Type" section, you can enter whether this is a passive mode connection or not. You can also specify any security measures. With the default "None" setting, FireFTP works just like any other FTP client, and performs no encryption of data. You can, optionally, choose from three different security settings, or choose SFTP, the secure form of FTP that uses ssh (see the SSH article elsewhere in this issue of the magazine). As such, you could conceivably use FireFTP to transfer files over a network, via ssh. At the upper right corner, you can turn on IPv6 internet addresses, simply by clicking on the check box.

Under the "Initial Directories" section, you can enter the default directory that you want to display on your local computer and the remote computer when FireFTP connects. Both entries are optional, but entering one or the other, or both, makes it easier when you launch FireFTP. For my local computer, I have it default to my "Magazine" directory, since I'm uploading files every month for the magazine.

There are four sections under the "Advanced" tab. The first, "Web host," allows you to specify what information (URL prefix) to place before a file name when you select the "Copy URL" task from the right-click context menu. Until you do this, you will not have use of the "Copy URL" function in FireFTP. The "Timezone Offset" allows you to (optionally) set your time zone's relationship to Greenwich Mean Time (GMT). The "Server Encoding" section allows you to change the character set used to match that used by the FTP server. Finally, the "Notes" section allows you to make notes about connecting to a particular FTP server, which is a much handier feature than keeping notes written in a notebook or on a piece of paper that are likely to become lost just when you need them.

**Impressions & Conclusion**

FireFTP is not only a very convenient and handy Firefox add-on, it's also one of the best written of the Firefox add-ons that I've seen. It remains unobtrusive and out of sight until you call for it. It's simple and straightforward to use, and the author considers it to be complete, with the exception of occasional bug fixes. He has been careful to not let FireFTP suffer from "feature creep," like some successful apps do. It has been written to perform one job, and it does that one job exceptionally well.
Let’s learn what it takes to receive and process a DVBStream, and burn it to DVD in PCLinuxOS.

The programs we need to use are:
- Kaffeine
- MANDVD
- Kover Artist (optional)

The first thing we need is a program to see what is on the DVB, assuming you have the necessary hardware.

**Kaffeine**

Once Kaffeine is installed via Synaptic, we need to start it up.

We are greeted by the configuration assistant, which helps with the configuration. It searches the system for codecs and DBV cards. Once installed, the following start window appears (Main Menu):

Choose “Record” on the left, and choose the record directory. Keep in mind to reserve at least 5GB for this, since the broadcast is in MPEG2 format. This is also important for a time delayed broadcast. The other items on the left are not subject to this tutorial.
To administer and search for your channels, press “Channels” in the DVB tab. Once that is done, you can choose “Digital TV” in the main menu and you should see this:

Relevant for us is the button with the red circle. Once we are finished recording, we will get a file like Cartoon.mts. This is not a file any DVD-player will be able to read, especially not the one underneath your TV. Even the occasional DVD authoring program might not work. That means we need a program which is able to read our stream, as well as convert it without compressing it again. There are programs around like ProjectX (not in the repos), or you could use my favourite, DVB-Cut.

DVB-Cut

Click on File > Open and select all files in order to display the m2t file. Save the index file by clicking “Ok”.

You can also remove advertising at the same time. Choose File > Export > Video and choose “Ok” in order to store your file in the source directory.

There you go. Follow the process in the displayed window. The resulting file will should be able to play in your media player of choice.

MANDVD

Even now and then, you might encounter the odd player not being able to play above file. To rectify this, we have the the DVD authoring program MANDVD.
First you need to create a project directory like /home/user/DVD.

Now choose “Add a video to your project.” Depending on space available, you can repeat that process.

The pictures should speak for themselves. Once you have selected all your videos, click next.

Here you choose your background, menu fonts as well as colors, etc.

Use the sliders to define the position of your Play button. Should you have more than one video in you compilation ensure that you use the “When this video ends” fold down menu in order to choose the
next video in line to be played once the first one ends.

Press “Generate DVD Structure” and watch it happen.

The rest is as easy as pressing the appropriate button to either write a DVD or create an iso image.

KoverArtist

The making of a cover with the program KoverArtist can be a bit confusing, once you try to generate an index. But even that isn’t a real problem.

Once we started up KoverArtist, we choose a cover. In this case, it is the standard DVD cover.

Insert the title and choose tab “Extras”. The cover will be searched on the Internet, and all we need to do is to insert it with drag and drop.

We remove the tick “Picture covers Page” and tick “Don’t show title text on front page.” The background color can be changed. The Standard color is white. The “Text Effect” is normally set to “none.” A little border might just round it off and give it a more professional look. Let’s get to the index in the next tab.

Here the drag and drop trick only works conditionally. The text line must not be too long, otherwise it might reach past the front page. We can not just remove part of the text since the second line is shown immediately. What I do is as follows:

Remove text which is too long.
Save project.
Close and restart program.
Open project and rewrite your shortened text line.

Now we change from “Project” to “Options”.
PCLOS is all I love baby
Of the others it's a cut above baby
Boot it up live it up don't take it from me
It's sublime you will find it always will be free

PCLOS looks oh so swell baby
Nothing else has such a shell baby
Get it today you'll know darn well baby
You'll love PCLOS too

PCLOS is just the best baby
It outshines all of the rest baby
Get it now and somehow you never will change
You will find all the rest will seem oh so strange

PCLOS is all you'll need baby
Use it everyday and you'll succeed baby
I love PCLOS indeed baby
You'll love PCLOS too
SSH: An Easier-Than-You-Thought Tutorial

by Paul Arnote (parnote)

SSH. Just say those three little letters, and you can literally watch the color drain from the face of many Linux users. It’s mysterious. It’s thought to be difficult to use. And, it uses the (Eeek!) command line.

Never fear. SSH is none of that. Actually, SSH, or more accurately, OpenSSH (the version in the PCLinuxOS repository) is easy to use, and can give you a very powerful tool that will make your life so much simpler. I hope that I can remove the shroud of mystery that surrounds it. The only thing I cannot change is that it is a command line tool, albeit a very easy one to use.

What's in it for me?

Here's my little scenario where I found ssh to be useful. You may have a very similar need. I literally have a fleet of 12 computers in my house, 10 of them running different flavors of PCLinuxOS. They all connect to the internet via my home network. Three of them are hard wired connections to the network, and the remainder connect via a wireless connection. Until recently, I did the production of The PCLinuxOS Magazine on my dual core laptop computer, which is the newest computer "in the fleet," before moving the bulk of the magazine production to my desktop computer. The desktop computer has two extra storage drives, totaling over 800 GiB of additional storage.

As you can imagine, with 12 different computers connected to the internet at different times, there is a wide variety of files that need to be archived or backed up. Before I learned about ssh, my only choice was to take one of three external portable USB hard drives, save the files to the USB hard drives, then transfer them to the additional storage media on my desktop. It always seemed that I was forgetting to back up one computer or another. Plus, because it became so time consuming, it was a task that I dreaded, and as a result, didn't do as often as I should.

Also, you can't even begin to imagine the volume of files that I have collected on my new laptop since just April 2010 from the production of the monthly magazine. Those files are beginning to take up considerable hard drive space on my laptop (over 2.6 GiB for just the magazine files). Although I rarely use them, I can't (for some reason) seem to part with those files and feel the need to archive them. Add to that mix 45 different ISOs of PCLinuxOS (some beta testing copies) totaling nearly 24 GiB of additional space, plus all of my music files (another 3.6 GiB), a large assortment of wallpaper files, and my video files (7.7 GiB), plus an assortment of all of my other files, you can see that the 160 GiB hard drive on the laptop is rapidly filling up. I simply needed an easier way to move files from one computer on my home network to another.

This is where learning how to run ssh has literally saved my neck. It's also taken an arduous, dreaded task and made it simple.

Why ssh?

Especially in the Linux corner of the universe, there are quite a few options that provide remote access to other computers on a network. Telnet, RDP, NFS, Samba and FTP are just five of several protocols that are popular among Linux users. Some, like Telnet and FTP, are insecure. Others, like Samba and NFS, are just a royal pain to set up and use. The tales are legendary and wide spread on Linux forums and message boards all over the place of someone having extreme difficulties either setting up or maintaining a properly working Samba or NFS.

This is where ssh comes in. To begin with, ssh stands for Secure SHEll. It provides a secure connection between two trusted computers. In its most basic form, you can log into another computer on a network, and use shell (bash) commands to navigate that remote computer. That remote computer could be just on your local network, or it could be halfway around the world, as you will see by the end of this tutorial.

It doesn't stop there (as you will also soon discover). You can also run GUI applications from the remote computer, right on your desktop, without having to have those applications installed on your local computer. Despite the mysteries associated with a lot of command line tools, ssh is actually fairly easy to use and run. You don't have the hassles and
headaches of setting up and maintaining file shares (with either Samba or NFS), since you pretty much have full access to the remote computer, just as you would if you had a user account set up on your local computer. Just as on your local computer, you will need access to the root account to make system-wide changes or install software on the remote computer.

Gaining access

To get started with ssh, you will need to enter something that resembles the following on the command line:

```
[parnote-xfce@localhost ~]$ ssh -l paul_lenovo 192.168.1.101
```

ssh invokes the OpenSSH version of the program.

-1 (small L) logs the listed computer as a trusted computer, and we only have to do this once (per remote machine, per local machine).

paul_lenovo is the user name on the computer that I want to log in under. Replace this with the user name you want to log into the remote computer as. The user account you select has to already exist.

192.168.1.101 is the IP address on my local home network for that computer. Replace this IP address with the one for the remote computer on your network that you want to log into.

Once connected, you will be prompted for the user password to gain access. This is the user password for the user you are attempting to log in as on the remote computer.

At this point, you have full command line access to the remote computer, and you can browse the files there just as if you were browsing the files on your local computer from the command line. In fact, you will notice that the user name on your command line has changed to the user you signed in as on the remote computer.

Now, log out of the ssh session. Don't worry, we're going to be going right back in. We just needed to "register" paul_lenovo as a trusted computer. To log out, type ~, at the command prompt. If you do this correctly, you won't see either character on the command line. The ~ is the escape character to send commands from the command line to ssh, while the . exits the connection. If you mess up (e.g., hit the ~ key twice), just hit enter to get back to a "virgin" command line and try again.

Accessing GUI apps

One of the real treats of using ssh is that you can run GUI applications from the remote computer right on your local desktop, without having to have that particular program installed on your local computer. To do this, we need to log back into the remote computer. Enter something like the following on the command line:

```
[parnote-xfce@localhost ~]$ ssh -v -X paul_lenovo@192.168.1.101
```

- v puts ssh into a verbose mode, so you can see any error and debugging messages.

- X enables X11 forwarding, and is what will enable us to run GUI applications that are installed on the remote computer, on our desktop.

paul_lenovo@192.168.1.101 is the user and IP address of the computer I want to connect to. Replace my user name and the address on my local network with the user name and IP address of the computer you want to log into.

If successful, you will be prompted for the user password to gain access, just as you were when we registered the remote computer as a trusted computer.

My desktop runs Phoenix Mini, while my Lenovo laptop runs KDE 4. As such, Dolphin (the KDE 4 file manager) is not installed on my desktop. Yet, once I have a successful connection, I can enter dolphin & on the command line, and Dolphin will fire up and display on my Xfce desktop. The & at the end of the command line runs Dolphin in the background, and returns control to the terminal.

It doesn't have to be just Dolphin that you run. You can run any GUI application installed on the remote computer, right from the comfort of your seat in front of your local computer. Below is a screen capture of me running Dolphin (installed on my Lenovo
computer running KDE 4) on my Xfce desktop (my
desktop computer running Phoenix Mini).

Transferring files

At this point, you cannot yet transfer files between
the two computers, at least as you might think you
would or should be able to. Fortunately, this is also
easily overcome, and there is a command line way
to accomplish the task, as well a a GUI method.
First, we’ll take a look at the command line method.

There are two programs associated with ssh, called
scp and sftp, and they stand for Secure Copy and
Secure FTP. Using these from the command line
allows you to use an ssh connection to transfer files
between computers. We’ll deal mostly with scp. The
sftp application is ideal for transferring individual files
over a ssh connection, especially when you know
you don’t want an entire directory. The scp
application, on the other hand, can handle individual
files, entire directories, and recurse any
subdirectories that may exist, copying all of those
files as well. Also, sftp is reported to be a bit slower
than scp at transferring files. Below is an example of
scp ”in action.”

```
scp -r paul_lenovo@192.168.1.101:/home/paul_lenovo/Wallpaper /home/parnote-xfce/Desktop/
```

scp invokes the secure copy program.

-r tells scp to recurse any and all subdirectories,
and copy the files stored there.

paul_lenovo@192.168.1.101 is the user and IP
address of the computer I will be connecting to.
Replace the user name and IP address with the user
name and IP address of the computer you want to
connect to.

```
/home/paul_lenovo/Wallpaper is the
directory on the remote computer that I want to copy
to my local computer. Replace this directory with the
path and name of the directory you want to connect
to on the remote computer.
```

```
/home/parnote-xfce/Desktop/ is where I will
be copying the “Wallpaper” directory from the
Lenovo (remote) computer, to my desktop computer.
Replace this directory with the path and name of the
directory where you want to save your files to.
```

Once the file copy is complete, I can then move the
folder off of my desktop to its “permanent” location
on my extra storage drives, or I can choose to leave
it on my Xfce desktop.

Of course, there is a GUI method to transfer files
over a ssh connection, as well. To get started, you
will need to install gsshsf from Synaptic, and it
stands for Gtk SSH File System. It allows you to
mount the indicated directory as a file system.

Once installed and started, it looks like this:

Click on the ”Add” button, then simply double click
your mouse under each category and fill in the
requested data. Under the “Host” column, fill in the
IP address of the computer you want to connect to. If
I were you, I’d leave the “22” under the ”Port"
column alone, since port 22 is most commonly used
for ssh connections. Fill in the user name you will be
connecting as, under the ”Username” column. The
 ”Directory” field is the directory you want to connect
to once you are logged in. The information under
 “Mount Point” will be filled in as you fill out the other
columns. Finally, place a check mark if you want
your local computer to mount the remote computer as a file system.

Once you select “Connect” from the buttons at the bottom of the window, your ssh connection will be made and you will have to enter the user password to gain access. Once you gain access, your file manager (Dolphin, Konqueror, Thunar, PCManFM, etc.) will automatically open on your local computer, already opened up to the directory you specified. From this point on, it’s a simple matter of opening up a second copy of your file manager and using drag and drop to move files from one computer to another. To the left is a screen capture showing me copying a LARGE number of files from my Lenovo (as the remote computer, bottom) to my desktop computer (as the local computer, top, running Xfce). I simply dragged the files from the bottom copy of Thunar to the top copy of Thunar. It literally was THAT easy.

As you can see, ssh makes sharing of files between computers on a local network a snap. But of course, there is more.

Transferring files, Part II

There is another way to transfer files between two computers, using an application from the PCLinuxOS repository that tends to be a perennial favorite. Using FileZilla, you can set up file transfers between two computers on a network, using sftp. At the upper right is a screen shot showing my connection from my desktop computer (parnote-xfce) to my Lenovo laptop (paul_lenovo).

To send your files to the remote computer (in this case, paul_lenovo, on the right), simply right click on the file on the host computer (parnote-xfce, on the left), and select “Upload” from the context menu. The selected file will be uploaded to the selected directory on the remote computer. Similarly, to move a file (or group of files) from the remote computer to the host computer, highlight the file(s) you want to copy, right click your mouse on them, and select “Download” from the context menu. Those selected files will be copied from the remote computer to the host computer, and placed in the selected directory on the host computer. I have found file transfers using FileZilla and sftp to be quite fast and reliable.

Setting up FileZilla to transfer files between two computers on a network is not difficult, at all. Select File > Site Manager from the menu bar, and you will be shown a window similar to the screen capture on the following page.

Click on the “New Site” button (left) to start an entry for a new site. Under the “General” tab, enter the host name or address on the “Host” entry line. Since I’m only using FileZilla here to transfer between two
computers on my local network, I enter the network address of the remote computer that I want to connect to. You can fill in the “Port” address, but for some reason, FileZilla will not preserve your entry here. The default port for ssh connections is 22.

Under “Server Type,” select “SFTP - SSH File Transfer Protocol” from the list it presents, rather than the insecure “FTP - File Transfer Protocol” setting that is the default. Connections using FTP are inherently insecure, since they are open and unencrypted, which means that anyone eavesdropping on the connection will also have full access to the data exchange. In contrast, an sftp connection is encrypted and secure.

Under the “User” field, enter the login name you want to use on the remote computer, and enter the user password on the "Password" line. This is the same password you would use if you were physically sitting in front of the remote computer and logging in.

Because of the use of the ssh, via sftp, to govern the transfer of data between computer connections, the use of this method should also be secure and free from worry as a method to connect to a trusted computer over the internet.

Globetrotting

Besides being useful for moving files across a local network (such as your home network), you can also use ssh to gain access to a computer half way around the world. To test this out, Sproggy set up an account for me on his computer in Bedford, England (point "B" on the right). I used my computer in Independence, MO, USA (point “A” on the left) to ssh into the account he created on his computer. In fact, the second entry in the gsshfs screen capture is my account on Sproggy’s computer.

Here is a screen capture of me running Thunar (from Sproggy's computer with Xfce) on my Lenovo laptop (running KDE 4):

To do this, there are a couple of “extra” steps you must take. First, you need to know the external IP address of the computer you are trying to connect with. This is the address that is provided by your internet provider – NOT the internal IP address on your local network. The easiest way is to point your browser to http://www.showmyip.com. Your external IP address will be shown in large numbers at the top of the screen.

Secondly, if you are behind a firewall or a router with a built in firewall, you will need to forward port 22 to the computer you are trying to connect to. It would be impossible to tell you how to do this for each and every one of the hundreds (if not thousands) of different routers on the market. It would be better to refer to the manual or documentation that came with your particular router. A good indication that the port is NOT open and/or that you are behind a firewall is that you will get a “connection timed out” error message.
Troubleshooting

There isn't a lot to troubleshoot with ssh. Probably one of the biggest problems is with misspelling. That is the first thing I check when I find that I cannot connect. The second thing to check is that you have the right user and IP address specified. Third, make sure the paths you type are valid. Do not expect ssh to create a directory for you. Rather, it must already exist.

I was trying to ssh into my test laptop with smurflover's e17 light installed on it. Despite everything else being correct, I kept getting a "connection refused" error. Upon further investigation, I discovered that sshd, or the ssh daemon, was not turned on in the PCLinuxOS Control Center. So, if you keep getting a "connection refused" error, check in PCC on the remote computer to make sure this is running. Go under System > Manage System Services, and look for "sshd." Set it to start at boot, and then hit the "Start" button to the right side. Chances are high that you'll now be able to connect. I found that KDE and Phoenix come with the ssh daemon already running. Other flavors of PCLinuxOS may not however, start it up by default, due to the choices the maintainer of the remaster made when they put it together.

Conclusion

As you can see, ssh really isn't the big scary monster that so many Linux users make it out to be. It's a very powerful tool that gives you the ability to share files between computers, as well as running applications you have installed on one computer without having to install it on a second computer.

There are a lot more things you can do with ssh that we didn't cover here. The intent here was to demonstrate the power of ssh to an ordinary Linux user, who may have several computers on his or her local network, and who may have a need to centralize and consolidate the files from those computers onto some sort of mass storage device. Or, perhaps the user just needs to access a file that is on another computer attached to the local network. With ssh, it's only a few keystrokes away, without even having to get out of your seat to go find it. With ssh, you can even "tunnel" past and through firewalls, with enough skill and luck. But this isn't something an ordinary, daily user of Linux has a need for, and these "extra" uses of ssh are left for you to explore on your own. For more information, simply do an internet search for "ssh man pages." There are several copies floating around the internet.

There are also programs that allow you to run ssh on Windows. So, if you have Windows computers still on your home network, ssh could be the answer you are looking for to share files between your PCLinuxOS computers and your Windows computers. Of course, since Mac OS-X is largely based on BSD Unix, Macs already have built in support for ssh.

Thanks to ssh, I now have full access to all of my files on all of my computers, without having to set up complex and confusing network file sharing utilities on each and every computer.
Screenshot Showcase

WindowMaker On PCLinuxOS: Introduction

by Patrick Horneker (phorneker)

What is WindowMaker?

WindowMaker is an attempt to implement the NeXTStep graphical interface on your PCLinuxOS desktop, and is installable from Synaptic. Simply open Synaptic, then click on Search and type in windowmaker. When the results appear in Synaptic, select task-windowmaker and click on Apply. Synaptic will automatically install any dependencies in addition to WindowMaker. You can install this from any PCLinuxOS variant, as there is no WindowMaker version of PCLinuxOS available.

Some Background on NeXT

To understand what WindowMaker is, here is a brief history of how NeXTStep came to be.

Back in 1988, Steve Jobs left Apple Computer to form NeXT, Inc. His aim was to create a new generation of computers for business use, supplementing the success of the original Macintosh. The result was the NeXT system. The CPU was a cube that sat on the floor of the desk, with a 21-inch flat screen monitor with built-in speakers, a keyboard and a mouse, all sitting on the desk, and all black in color. The system came equipped with 16MB of RAM, a Motorola 68040 processor, a hard drive (about 80MB, which was plentiful for its time), and an optical disk reader/writer, which was a predecessor to the current CD-RW and DVD-RW drives we use today.

The NeXT system was hardware compatible with the Macintosh systems at the time, so mice, landline modems (remember those) and printers were available.

Software-wise, the NeXT used a Mach kernel (a predecessor to GNU/Hurd and Darwin), along with standard GNU tools for software development. Programming for NeXT was done in Objective-C, which is now the official programming language for iPhones, iPads, iMacs and MacBooks. Programs written in Objective-C for Apple's gadgets, as well as applets designed for the NeXT system, NeXTStep, and WindowMaker itself, have the .app extension, indicating that this is an application. In fact, the term App, as in "There's an app for that," was derived from this concept more than it was an abbreviation of the term application.

NeXTStep was the operating system that ran on NeXT. The interface was very simple. What you got was a black background, with a expandable dock on the upper right hand corner of the screen with 64 x 64 pixel icons. To get the system menu, right click anywhere on the background.

At the time of Apple's acquisition of NeXT, Inc. (which brought Steve Jobs back to Apple), NeXTStep was available for PowerPC, Motorola 68x and Intel x86 processors. The last version of NeXTStep before the Apple acquisition was 3.3.3. NeXTStep continues to this day in two forms.

GNUStep incorporates WindowMaker as its official desktop. In addition, GNUStep implements an open source version of the NeXTStep API, not just the graphical elements. You can install GNUStep on PCLinuxOS, but the conflict here will be with the make utility. GNUStep implements make in such a way that the standard make utility cannot be used.

The commercial version of NeXTStep survives as Mac OS-X, and currently uses a BSD kernel instead of a Mach kernel, in addition to a user interface that utilizes DisplayPDF, and rivals that of GNOME and XFCE.

We only need WindowMaker

The main difference between GNUStep and WindowMaker is that GNUStep implements the entire NeXTStep system, not just the interface. For PCLinuxOS, we only want the interface, and WindowMaker is one way to implement that interface.

The PCLinuxOS repository contains WindowMaker, along with some useful dock applets. You will still be able to run all of your applications that you installed on your PCLinuxOS system (be it KDE, GNOME,
XFCE, etc.), but you can run them through a NeXT-like interface.

To run WindowMaker, you will need to select WindowMaker from the login screen.

If you are running the original PCLinuxOS distribution (or the MiniMe variant), you need to select WindowMaker from the Session menu.

For all other variants, you will need to click on the Menu icon (the left most button below the entry box in PCLinuxOS GNOME edition), or wherever the Session menu is for your PCLinuxOS variant. When the session menu pops up, select WindowMaker, then click on OK.

For the PCLinuxOS GNOME Edition, you will be asked if you want to make WindowMaker your default window manager for future sessions.

The screen pictured above is what you see when you launch WindowMaker on PCLinuxOS.

This is very much what the original NeXT system screen looked like in its day. Looks boring, doesn't it? The good news is that most anything here can be changed.

There are some differences (other than the background color) between WindowMaker and the NeXTStep interface. The lower left hand corner of the screen displays icons representing applications that are now running (and any child windows opened belonging to the application). The upper left hand corner is a clip. This clip is used to switch between workspaces, not unlike what is available in KDE, GNOME, XFCE, LXDE or Enlightenment. The icon showing here represents the shutter screenshot utility (also installable from Synaptic).

PCLinuxOS has a better way to control WindowMaker.

Open the system menu and click on More Applications -> Configuration -> WindowMaker Configuration Manager.

This opens the alternate utility for WindowMaker configuration, and gives you more control over WindowMaker than the Preferences utility.

WindowMaker Configuration Manager

Right clicking anywhere on the background will pull up the system menu (shown here). This is the same menu that you see on any other desktop offered with PCLinuxOS.

Double clicking on the icon at the top of the dock (the one with the WindowMaker logo) will open WindowMaker Preferences. This is one way to customize WindowMaker to your tastes.

When you first launch this WindowMaker utility, you will see a message that says .wmakerconf does not exist. Click on Yes to create that directory in your home directory to store your preferences.
**PCLinuxOS Gnome Edition Users:** Behind the utility window is another window showing that it cannot find the default wallpaper supplied with Mandriva's packaging of WindowMaker.

We can see here that WindowMaker comes with lots of settings for you to configure, not to mention the potential for lots of eye candy.

**Note:** WindowMaker has its own menu configuration, in terms of the format in which the menu is stored. You can use WindowMaker's own format for storing menus, but be warned of this: the WindowMaker format is not compatible with the menuing system used by PCLinuxOS or by Mandriva (on which this implementation of WindowMaker is based).

If you choose to use WindowMaker's internal menu system, those menus will not be updated when you update or add software to PCLinuxOS.

All other settings herein are safe to use and configure. Note: WindowMaker has not been updated since 2008, so the chances of an update for this are quite slim, yet the window manager still works to this day.

**WindowMaker Themes**

Like the other desktops that come with PCLinuxOS, WindowMaker comes with its own set of themes. In a later article, I will show you how to create your own themes for WindowMaker.

The PCLinuxOS repository provides a set of themes for WindowMaker, installable from Synaptic. These are stored at `/usr/share/WindowMaker/Themes` and are available to any user on your machine.

You can install your own themes by placing them in `~/GNUStep/Library/WindowMaker/Themes`, with `~` representing your home directory.

Themes are packaged as standard `.tar.gz` files.

So where do we get themes? Some sources for prepackaged themes are as follows:

- [http://lonelymachines.org/windowmaker-themes/](http://lonelymachines.org/windowmaker-themes/)
- [http://themes.freshmeat.net/](http://themes.freshmeat.net/)
- [http://box-look.org](http://box-look.org)

You can also perform a Google search, using “windowmaker themes” as your search term, to find other sources for themes.

This is only an introduction to WindowMaker. In future articles, I’ll show you next some basics on configuring WindowMaker under PCLinuxOS.
Computer Languages from A-Z: Vala & Visual Basic

by Gary L. Ratliff Sr. (eronstuc)

As we approach the tail end of the alphabet we notice that the number of languages which are available specifically for PCLinuxOS are rapidly decreasing, or even reaching the vanishing point. For that reason, this article will present two languages. One is a new language which is designed to only function on the Gnome desktop of Linux. The other is the language which made creating GUI applications in Windows an easy task: the venerable language Visual Basic. The version of this language selected has the redeeming feature of being available at no cost.

As an example, under a list of languages beginning with the letter X, I found the language Xi. It is a computer language that was available for the Univac computer. I have a picture taken many years ago of my now 28 year old son (Gary II — he never liked being called Junior) wearing diapers and typing away at the keyboard of the Commodore PET, which I purchased in 1978. Meanwhile I am in this same picture, typing on the Super-PET which was purchased in 1981, just a few months before he was born. I doubt that Gary II, who has been dealing with computers ever since the first months of his life, would be able to tell you just what a Univac might be.

I vaguely recall that the Univac was a very early computer, and it may have been the one used in the show $64,000 Question, which created a scandal as the producers of the show were giving the answers to one player in favor of the other. It was this very show which brought Dr. Joyce Brothers into much fame as being one of the high money winners on that show.

Now those who actually remember the Univac would have spent some time punching in their program into Hollerith cards using an IBM keypunch, and then taking this deck of cards and merging it with a deck of cards containing the Job Control language for the system, and then having the system compiled and executed. One of my FORTRAN IV programs contained what I later learned to be a missing comma, and my program was stopped after too much CPU time was spent on the main frame. My flawed output from the program was pages and pages of neatly formatted zeros, instead of the amortization schedule which I expected.

However, most of the current generation would be like my son and have no idea of just what Univac might be.

The Vala Computer language

The Vala computer language is a new programming language, developed by Jorg Billitter and Raffaele Sandrini. The object is to create a language which will bring modern language features to the C language. This system will compile its code into the C language, which will then be compiled using a standard C compiler. This language is specifically for the Gnome desktop. If you enter the word vala into Synaptic, you will find it listed. However, as I am using the very newest KDE version on my main computer, this will not produce any useful output, as it will not have the Valac compiler, nor will KDE have the required Glib and GObject libraries, which are a part of the standard Gnome desktop.

For the purpose of testing the language, I used my partition which is devoted to version 10.04 of Ubuntu. I asked for the full system and the documentation for Vala. You can find the documentation for Vala, as well as a great tutorial for the language, on the main web site:
http://live.gnome.org/Vala.
By clicking the link on the above page, you will be directed to the tutorial, which will cover the features of the language, along with details of its use.

(Editor Note; Due to the length of some lines of code below, individual lines will have spaces between them except the first 5 lines starting with #include.)

/* hello.c generated by valac, the Vala compiler * generated from hello.vala, do not modify */

#include <glib.h>
#include <glib-object.h>
#include <stdio.h>
#include <stdlib.h>
#include <string.h>

#define DEMO_TYPE HELLO_WORLD (demo_hello_world_get_type ())

#define DEMO HELLO WORLD(obj) (G_TYPE_CHECK_INSTANCE_CAST ((obj),
DEMO_TYPE HELLO WORLD, DemoHelloWorld))

#define DEMO HELLO WORLD CLASS(klass) (G_TYPE_CHECK_CLASS_CAST ((klass),
DEMO_TYPE HELLO WORLD, DemoHelloWorldClass))

#define DEMO IS HELLO WORLD(obj) (G_TYPE_CHECK_INSTANCE_TYPE ((obj),
DEMO_TYPE HELLO WORLD))

#define DEMO IS HELLO WORLD CLASS(klass) (G_TYPE_CHECK_CLASS_TYPE ((klass),
DEMO_TYPE HELLO WORLD))

#define DEMO HELLO WORLD GET CLASS(obj) (G_TYPE_INSTANCE_GET_CLASS ((obj),
DEMO_TYPE HELLO WORLD, DemoHelloWorldClass))

typedef struct _DemoHelloWorld DemoHelloWord;

typedef struct _DemoHelloWorldClass DemoHelloWorldClass;

typedef struct _DemoHelloWorldPrivate DemoHelloWorldPrivate;

struct _DemoHelloWorld {
    GObject parent_instance;
    DemoHelloWorldPrivate * priv;
};

struct _DemoHelloWorldClass {
    GObjectClass parent_class;
};

static gpointer demo_hello_world_parent_class = NULL;

GType demo_hello_world_get_type (void);

enum {
    DEMO HELLO WORLD DUMMY PROPERTY
};

gint demo_hello_world_main (char** args, int
args_length);

DemoHelloWorld* demo_hello_world_new (void);

DemoHelloWorld* demo_hello_world_construct (GType object_type);

gint demo_hello_world_main (char** args, int
args_length) {
    gint result = 0;
    printf (stdout, "Hello, World\n");
    result = 0;
    return result;
}

int main (int arge, char ** argv) {
    g_type_init ();
    return demo_hello_world_main (argv, arge);
}

DemoHelloWorld* demo_hello_world_construct (GType object_type) {
    DemoHelloWorld * self;
    self = (DemoHelloWorld*) g_object_new
    (object_type, NULL);
    return self;
Computer Languages from A-Z: Vala & Visual Basic

```c
GType demo_hello_world_type_id;

demo_hello_world_type_id =
g_type_register_static (G_TYPE_OBJECT,
"DemoHelloWorld", &g_define_type_info, 0);

GType demo_hello_world_type_id;

// The Vala language makes using the newer object
// orientated features of other languages easily
// achieved in C. As it is much easier to learn than
// would be the C required to achieve this, it has come
// into wide use. Also, the Valac compiler may be used
// to compile another new language, Genie, and
// several examples of this use are presented in the
// September 2010 issue of Linux Pro Magazine, in
// the article “In the Bottle” by Ankur Kumar. The main site
```

This file shows that the output from the familiar hello world program written as
hello.vala, for which the code is shown in the tutorial as the first programming example, is indeed
translated into a C program. If you key in the code of
the hello.vala program and compile it with the vala
compiler using valac hello.vala, you will create an
object program which may be executed by issuing the
command ./hello.

The Vala language makes using the newer object
orientated features of other languages easily
achieved in C. As it is much easier to learn than
would be the C required to achieve this, it has come
into wide use. Also, the Valac compiler may be used
to compile another new language, Genie, and
several examples of this use are presented in the
September 2010 issue of Linux Pro Magazine, in
the article “In the Bottle” by Ankur Kumar. The main site
also covers the features of the Genie language
(above.)

**Visual Basic**

You will learn that the items available in Visual Basic are
very much like those available in Gambas. In fact, the Gambas system even has a feature which
will allow translating the Visual Basic code into the
Gambas Basic dialect. So, in this way, Visual Basic
has appeal to Linux users. Microsoft has made a
limited edition of the program available for free.
Quite naturally, this system runs under Windows. If
you type the phrase “free Visual Basic” into the
Google search engine, you will soon find an item
which will direct you to the Microsoft download area.
There is more than one version available for free use. One will allow creating Active X components, but will prevent creating the output as a Windows *.exe file that can be used. The version we are interested in is the Limited Edition of Visual Basic 2008.

The program will operate for 30 days without being registered. However, if you wish to create applications which you may use on your Windows system, it is best to register the product. Here you obtain a passport, and you do that by submitting your current email address or entering your address at either hotmail or msn.com. If you have previously established an account with these and have forgotten the password, a message will be sent to your main email address, which will have a message sent to you, allowing you to reset your password, and thus enabling you to register the product.

This is what the opening screen will look like, once you have the product installed (right):

As this is created using the Windows method of creating a screen shot, you can begin to appreciate the advantage of being able to take screen shots in the PNG format. Here, while loading this into the document, which is located on my Ubuntu 10.04 partition, I noticed that the BMP version of the screen shot takes 3.8 megabytes. That means that the two examples shown in this document alone take 7 megabytes. Many mail systems would not allow sending such a large document. So, a screen shot program which produced PNG output for Windows would be a useful item.

The system has a set of tutorials, and these are presented as video files, which will play on the Windows Media player. They may also be saved to the video area of “My Documents.”

The initial tutorial shows how to create a web browser within a frame. It uses a text box and a label box to allow entering the URL of the site you wish to view. The system has many such tutorials, enabling you to quickly learn the language, and to become proficient using Visual Basic. Essentially, one selects the items needed, and drags them into place on the form. See the default form for a Windows Application: (below right)

The tutorials continue to demonstrate how to code the actions required when you interact with the form. Now that we are in Windows, the live.gnome.org site also mentions that there is a binary version of Vala for Windows. This loads a minimal G object system into Windows so that the programs will compile using the required Glib and G object features. I know that there is a Gnome version of PCLinuxOS. However, I did not test it on PCLinuxOS Gnome, since when I upgraded to the latest KDE version of PCLinuxOS, I overwrote my partition that was formerly occupied by PCLinuxOS Gnome 2009.2.
**Game Zone:**

**DOD:S & Steam Tips For Dual Booters**

by glamdring

When I first started using Wine, I tried to get Valve games running, because Valve made some of my favorite games. Valve started out with the game Half-Life, which spawned many mods. One of my favorite mods was Day of Defeat, and after the release of Source came Day of Defeat: Source.

**About Valve**

Valve is an entertainment software and technology company founded in 1996. In addition to creating several of the world’s most award-winning games, Valve is also a developer of leading-edge technologies, including the Source® game engine and Steam®, the premiere online gaming platform.

**About DOD:S**

Day of Defeat: Source features multiplayer, team-based gameplay set in the WWII European theatre of operations. Players choose a role and tackle goal-oriented missions based on historical operations.

Day of Defeat: Source takes the classic game play of the original Day of Defeat, and improves the experience with Source, the advanced engine technology Valve created for Half-Life 2. With this technology, DoD: Source offers state of the art graphics (including support for HDR lighting) in optimized versions of popular maps, plus redesigned sound and all new player, weapon, and world models.

**Getting The Game**

For setting up the game, I use Play On Linux. PCLinuxOS users can find this in Synaptic. Launch Play On Linux, click “Install” and search for “Steam.” Select the option that only includes Steam and no other game. When the install is done, launch Steam and install Day of Defeat Source. You should be able to play this game using the default settings. If you do not own the game you can buy it digitally in the Steam store. It costs only $10 U.S.

The Game

When you first launch the game, you will be given a list of options. I recommend you first go to your controls and make sure you are comfortable with the settings. I suggest you then go to the customize section and change your name from player to what ever you want. Most games use this to allow a user to enter their screen name and gamer tags. You should also spend some time exploring the options. You will find some useful things like mouse sensitivity, volume, and mic controls in the options.

When searching for a server, you can either use the simple search or the advanced version. I suggest you get used to the advanced version, because it allows you to see more servers and the ability to sort them easily. Some important things to look for in a server are the ping, VAC, and number of players. The ping measures the amount of time it takes for a packet to go from your computer to the host and
back. The lower the value, the better. VAC stands for Valve Anti-Cheat, which attempts to detect modifications made to a game to help someone play a game better. VAC bans will completely remove your ability to play on VAC secure servers, rendering the game almost useless. One thing to keep in mind when looking at servers is not only how many players are playing, but also the maximum number of players. If you have a bad Internet connection, playing on a server with fewer players can help.

After connecting to a server, you will be prompted with a choice between two teams, Axis and Allies. Most of the time, it is best to hit auto team select. This will automatically put you on the team with fewer players or currently losing. When you select a team you will get the option to choose your class. This determines what guns you get, plus some additional items. It is a good idea to read what each class gets, but it’s probably best to give them all a try.

The guns have very high kick, and you may find this very frustrating at first. As you get used to the game, you will find the accuracy to be much closer to real life than most WWII games. Also, this high kick helps keep someone from learning exactly where to aim to get that perfect shot every time. This game has a steep learning curve for new users, but once you get the hang of the basics, you will find yourself killing some experts.

System Requirements
(From valve rated for Windows)

- **Minimum:** 1.7 GHz Processor, 512MB RAM, DirectX® 8.1 level Graphics Card (Requires support for SSE), Mouse, Keyboard, Internet Connection

- **Recommended:** Pentium 4 processor (3.0GHz, or better), 1GB RAM, DirectX® 9 level Graphics Card, Mouse, Keyboard, Internet Connection

- **My system:** i5 M520 2.4Ghz Processor, 4Gb 1066 DDR3 RAM, 1GB NVS 3100 Graphics Card, 2.5 MB/s Internet Connection, PCLinuxOS: KDE

Tips for dual-booters (Windows)

**WARNING:** When a file/folder is linked changing it will change your source file/folder (This can change settings to games etc on your Windows side)

The first tip will save you a lot of space and time. Instead of re-downloading all your games and filling up your hard drive, you can link your steam folders. In this instance I will be linking the steamapps folder, rather than the whole steam folder. First, make sure you know the location of your Linux and Windows steam files. If you installed with Play On Linux, go to your home folder “/home/youruser.” If you do not have hidden files set to be viewable, you will need to do so. You can do this by clicking on “View” and make sure “Show Hidden Files” is checked. By default, steam should be installed in your “.PlayOnLinux/wineprefix/Steam/drive_c/Program Files/Steam” folder.

To find your Windows Steam file, go to root and look for “media.” Inside will be a list of mounted media. In some cases you will need to mount your Windows media, but with PCLinuxOS, it is typically already mounted. The name of your Windows media will most likely be something like “disk.” If you want your media to auto-mount and it does not already, go to Configure your Desktop in KDE 4, go to the Hardware section, and click on “Removable Devices.” Here, you can edit what devices will auto mount. Now browse to your steamapps folder on Windows. It should look like “Program File (x86)/Steam/steamapps” (the (x86) is for those running 64-bit Windows).

To link your steamapps folders, we will use a symbolic link. First, you will need to rename the steamapps folder in steam to something like o_steamapps. I like to keep the old version in case something goes wrong. Now that you know both locations of steam, open the terminal and cd to the steam folder on Linux. The command should look like this:

```
cd /home/youruser/.PlayOnLinux/wineprefix/Steam/drive_c/"Program Files"/Steam
```
Now we will create a symbolic link using the `ln -s` command. To use the `ln -s` command, you have to `cd` to the location of the folder you want to link (like we just did earlier) and begin by typing `ln` (for link) and `-s` (for a symbolic link), followed by the location of the folder you want to link to (in this case, the Windows destination of Steam), followed by the name of the folder you want to link (In this case steamapps).

If you used `ln -s` correctly, your command should look like this:

```
ln -s /media/disk/"Program Files (x86)"/Steam/steamapps steamapps
```

Now if you check your steamapps folder in Play On Linux, you should see a folder with an arrow on it.

```
steamapps
```

**WARNING:** Linking your Windows folder can cause damage to Windows and may even make it unusable if you are not careful. It is **HIGHLY** advised you make a copy of your Windows folder and link the copy instead of linking the original!

Using your Windows folder in place of the current Windows folder in PlayOnLinux can sometimes improve overall game quality. You can use a symbolic link, like we did with the steamapps directory, but this can damage your Windows folder, so I will step you through copying it instead. Browse to your Windows mount like earlier by going to `/media/disk` and find your Windows folder. Right click on it and select copy (make sure you don’t click cut!). You can now paste this folder wherever you want. I prefer to put it in my home directory for convenience. Now, any time you want to use those files, you can use a symbolic link to use those files instead. Your symbolic link should look like this:

```
ln -s /home/Windows Windows
```
More Screenshot Showcase


Top Right: Posted by blindschLeiche, January 24, 2011, running LXDE.

Bottom Left: Posted by loukingjr, January 10, 2011, running OpenBox.

Bottom Right: Posted by parnote, January 26, 2011, running Xfce.